So you’ve been told you are going to do a systematic review?

Greg Sheaf, Trinity College Library Dublin

Presentation to be e-mailed to you later...
Who is this guy?

• Former Nursing & Midwifery Subject Librarian – was in post here in TCD from Oct 2005 to March 2014
• Currently Physics & Chemistry Subject Librarian and Web Services Librarian
• Co-author on several articles produced by the SofNM including a Cochrane Review
• Advised thousands of students and staff on searches and dozens on systematic reviews
• E-mail: greg.sheaf@tcd.ie
• Tel: 01-8962928
Our focus today is the search, rather than deciding on relevancy, or critically evaluating results, or using statistics. I’m sticking to what I know 😊

Your searches are the entire foundation of a systematic review

You want to be confident you have found every relevant study, to the best of your ability

If the searches aren’t good enough, the whole thing is flawed
Don’t go cherrypicking

• Cherrypicking is the most common type of searching
• Searches are based on a few keywords or an author and the researcher mines through the information picking the articles which interest them (like cherries from a tree)

• Some problems
  • lack of consistency
  • uncertainty whether you have “got everything”
  • lack of methodology makes it impossible to replicate across databases or by others

• But! You have to start somewhere – can be useful to get a feel for a subject, and find themes and terms
Systematic searches

• Systematic searches can be used across multiple databases and by multiple people. Results can be replicated by others

• A core of terms is used across multiple databases, with additions and subtractions as necessary. For example, the part of a search looking for RCTs doesn’t need to be included in a database composed of RCTs

• Future researchers can carry on where you left off, for example can conduct a Cochrane Review using your search terms
Systematic searches versus systematic reviews

• *All* your searches should be done systematically, but don’t necessarily need to find every single relevant article or study

• For example, a search for a literature review gives a sample of evidence – it doesn’t aim to be totally comprehensive, instead it aims to find the most important works

• A systematic review is done using systematic searching, but most systematic searches are not systematic reviews
Why a systematic review?

• Systematic reviews are one of the hardest things you can do academically... but one of the most rewarding. They can find actual answers to real-world problems – even if that answer is “we don’t know the answer yet”

• Gaining popularity at thesis level - as they are literature-based only, they don’t require ethical approval

• You have to become really, really good at searching

• Not just for the biomedical sciences, or RCTs within them – now used in many disciplines, and using qualitative studies
PRISMA (Preferred Reporting Items for Systematic Reviews and Meta-Analyses) Statement

“A systematic review is a review of a clearly formulated question that uses systematic and explicit methods to identify, select, and critically appraise relevant research, and to collect and analyze data from the studies that are included in the review. Statistical methods (meta-analysis) may or may not be used to analyze and summarize the results of the included studies. Meta-analysis refers to the use of statistical techniques in a systematic review to integrate the results of included studies.”

http://prisma-statement.org/statement.htm
Nursing and midwifery - places to look

• Biomedical databases – principally PubMed, CINAHL, PsycINFO, Cochrane, EMBASE. Multidisciplinary databases like Scopus, Web of Science, ScienceDirect... and Google Scholar. Please make sure you spell them correctly!

• Directly in any journals you know of, that aren’t included in the above, or where there is a delay – more on this later

• “Grey” literature – internal documents, reports, conference proceedings. These are a pain to find and just as much of a pain to search within

• Theses – use the theses databases from ProQuest via the Library

• For RCTs – the above but also CENTRAL via Cochrane, and the current trials databases (e.g., ISRCTN and ClinicalTrials.gov/). Support the AllTrials initiative!
The elephant(s) in the room
What about Google – and Google Scholar?

• Both are great for quick and dirty searches to get started
• No-one outside Google really knows how Google assigns relevancy
• Google Scholar is brilliant to find a particular article you already know about, or others that cite it
• It’s very likely articles you want but don’t know about are listed in Google Scholar. But finding them is another matter!
• The ability to search Google Scholar like other databases just isn’t there at present
• Good explanation in The comparative recall of Google Scholar versus PubMed in identical searches for biomedical systematic reviews: a review of searches used in systematic reviews (Bramer et al. 2013)
The anatomy of a systematic review

- [http://prisma-statement.org/2.1.4%20- %20PRISMA%20Flow%202009%20Diagram.pdf](http://prisma-statement.org/2.1.4%20-%20PRISMA%20Flow%202009%20Diagram.pdf)
Tips, tricks and things to look out for...
PICO is your friend

- P=Patient or Population
- I=Intervention or Issue
- C=Comparison (often optional)
- O=Outcome/Measurement

- For example:
  “In college students (P) are nicotine-replacement interventions (I) effective compared to placebo (C) in increasing smoking cessation (O)?”
Even when a journal *is* indexed in a database, there may be a delay...

- For example, I’m currently involved in a project looking at chaplaincy services in hospitals
- One of the key databases for this is a theological database compiled by the American Theological Library Association (ATLA)
- This indexes the relevant periodical, Journal of Pastoral Care & Counseling
- In January 2015 the latest issue is 68:4 December 2014. But only articles up to March 2014, 68:1, are appearing in the database
- So you have to search on the journals website (putting in a date limit) to get the newer articles. Three issues worth
- How are you supposed to know this?
“Hard” searches are easy, “soft” searches are hard

• Searches for well-defined terms – conditions, for instance – are normally quite simple. They generally have a standardised index term, and only a few synonyms

• But searches for “softer” terms are much, much harder, as there are often so many variations of the idea it could be

• I’m looking for “people’s experiences of...”

• Most searchers will only search for the exact word “experiences”

• But what words *could* it be?

• Have a think, write them down!
“Hard” searches are easy, “soft” searches are hard II

• As well as “experiences”, ANY of the below could be used instead in an article:

• experience OR experiences OR experienced OR view OR views OR viewpoint OR viewpoints OR perception OR perceptions OR perceive OR attitude OR attitudes OR belief OR beliefs

• ...you can probably think of more!
The dubious joy of PubMed’s autosearching

- You are looking in PubMed for articles on obstetric labour. You type in *labour*
- It automatically searches for *labour* *and* *labor* – GREAT!
- But it also automatically searches for *work* – both as a term anywhere, and as the MeSH term *work* – NOT SO GREAT
- I think that over 90% of the *labor* results are not to do with obstetric labour
- Aaargh!
Labour=Labor=Work in PubMed

- All the results for labour appear within the results for labor (proved by #10)
- Unfortunately, so do all the results for work (proved by #12)
- Only a small proportion of the results for labor are actually for that word; most are for work
- You can see this in search #13 - (labor OR labour) NOT work. Note, this excludes results that mention both labor/labour *and* work in the same record, so it’s imperfect
Fun with midwifery...

• Search for *midwifery*
• Search for *midwife*
• Search for *midwives*

• What’s going on???
Fun with midwifery II

• Search for **midwifery** = "midwifery"[MeSH Terms] OR "midwifery"[All Fields]

• Search for **midwife** = "midwifery"[MeSH Terms] OR "midwifery"[All Fields] OR "midwife"[All Fields]

• Search for **midwives** = "midwifery"[MeSH Terms] OR "midwifery"[All Fields] OR "midwives"[All Fields]
Fun with midwifery III

• Searching for any of the terms midwifery/midwife/midwives automatically searches for midwifery as a word anywhere in a record. This is not helpful...

• ....as it is also searching the Author Affiliation field, and getting any record that e.g., is noted as being written by someone at a “School of Nursing and Midwifery”

• Note that midwives *doesn’t* search for midwife and vice versa
Frozen shoulder contracture syndrome - Aetiology, diagnosis and management

Lewis J.1

Author information

1Department of Allied Health Professions and Midwifery, School of Health and Social Work, Wright Building, College Lane Campus, University of Hertfordshire, Hatfield AL10 9AB, Hertfordshire, UK. Electronic address: jeremy.lewis@LondonShoulderClinic.com.

Abstract

Frozen shoulder is a poorly understood condition that typically involves substantial pain, movement restriction, and considerable morbidity. Although function improves over time, full and pain free range, may not be restored in everyone. Frozen shoulder is also known as adhesive capsulitis, however the evidence for capsular adhesions is refuted and arguably, this term should be abandoned. The aim of this Masterclass is to synthesise evidence to provide a framework for assessment and management for Frozen Shoulder. Although used in the treatment of this condition, manipulation under anaesthetic has been associated with joint damage and may be no more effective than physiotherapy. Capsular release is another surgical procedure that is supported by expert opinion and published case series, but currently high quality research is not available. Recommendations that supervised neglect is preferable to physiotherapy have been based on a quasi-experimental study associated with a high risk of bias. Physiotherapists in the United Kingdom have developed dedicated care pathways that provide; assessment, referral for imaging, education, health screening, ultrasound guided corticosteroid and hydro-distension injections, embedded within physiotherapy rehabilitation. The entire pathway is provided by physiotherapists and evidence exists to support each stage of the pathway. Substantial on-going research is required to better understand; epidemiology, patho-etiolog, assessment, best management, health economics, patient satisfaction and if possible prevention.

Copyright © 2014 Elsevier Ltd. All rights reserved.

KEYWORDS: Assessment; Frozen shoulder; Management

PMID: 25197526 [PubMed - in process]

Related citations

ELSEVIER

FULL TEXT ARTICLE
School’s out...

• Researchers looking at issues affecting children often search for the word *school*

• Of the *2443966* results for *school* on 19/01/15, *2228493* do not mention school in the title, abstract or as a MeSH term

• Over 90% of the *two-and-a-half million articles* that have been added to a search looking for info on children are likely to be irrelevant
Truncation isn’t necessarily a good idea

• PubMed allows you to use an asterisk to find records that mention that word or anything that has that “stem”. This seems like a clever way to search, right?

• It turns off the automatic mapping of terms that occurs behind the scenes (so brain cancer* will not find the MeSH term Brain Neoplasms or include any of the more specific subterms, such as Cerebral Ventricle Neoplasms, Neurocytoma, or Supratentorial Neoplasms). OK so long as you realise that...

• Retrieval is restricted to the first 600 variations of the truncated term

• How can there be 600 variations of something???
Anisotropic hyperelastic behavior of soft biological tissues.

Chen ZW¹, Joll P, Feng ZQ.

Abstract

Constitutive laws are fundamental to the studies of the mechanically dominated clinical interventions involving soft biological tissues which show a highly anisotropic hyperelastic mechanical properties. The purpose of this paper was to develop an improved constitutive law based on the Holzapfel-Gasser-Ogden's model: to replace the isotropic part with Gent constitutive law so as to model the noncollagenous matrix of the media due to its generality and capability to reproduce the Neo-Hookean model. This model is implemented into an in-house finite element program. A uniaxial tension test is considered to study the influence of material parameter \[\text{Formula: see text}\] in Gent model and \[\text{Formula: see text}\] which represents the angle between the collagen fibers and the circumferential direction. A simulation of an adventitio strip specimen under tension is performed to show the applicability of this constitutive law.
So what are you supposed to do?
Slice it up

• Divide up your search into its constituent parts. Use PICO as a start:
  • P=Patient or Population
  • I=Intervention or Issue
  • C=Comparison (often optional)
  • O=Outcome/Measurement

• Another useful variable is time
Take control

• Always see if the database uses “controlled vocabulary”. Basically, standardised subject terms
• In PubMed, MeSH – Medical Subject Headings
• In CINAHL, CINAHL Headings
• In PsycINFO, PsycINFO Descriptors

• You need to know whether these terms are automatically “exploded” or not. PubMed auto-explodes, CINAHL doesn’t
• The description may list “entry terms” or “used for” words, that can be used as keyword synonyms
Think of synonyms

• Use a thesaurus
• Ask a friend or colleague for five words that mean the same as X
• You might see more when you are looking at the “entry terms” for a controlled vocabulary item. Some will be the same words in different order, or as plurals. Pick out the unique words
Entry terms for MeSH term Rubella – as found by typing in German Measles into MeSH database

Entry Terms:
- Rubellas
- Three Day Measles
- Measle, Three Day
- Measles, Three Day
- Three Day Measle
- Measles, German
- German Measles

All MeSH Categories
- Diseases Category
  - Virus Diseases
    - RNA Virus Infections
      - Togaviridae Infections
      - Rubivirus Infections
        - Rubella
        - Rubella Syndrome, Congenital
Keywords from the Rubella MeSH entry

• *three day* OR *German*
• *measles* OR *measle*
• *rubella* OR *rubellas*

• You want:
  
  *three day* OR *German*
  AND
  
  *measles* OR *measle*
  AND THEN OR
  
  *rubella* OR *rubellas*
“Measle”? “Rubellas”? Really?

• In PubMed, about five entries (from 24,000,000 plus) seem to only have *measle* but not *measles* in the title or abstract, nor a measles-relevant MeSH term

• *Rubellas* only appears in one title/abstract – and so does rubella in that record anyway

• Well, you can’t be accused of not being thorough!
Search for your keywords

• Normally best to limit to title and abstract, if you are also running controlled vocabulary searches
• Note that in PubMed this automatically runs a phrase search:
  “folic acid”[Title/Abstract]
  =
  folic acid[Title/Abstract]
  =/= 
  folic[Title/Abstract] AND acid[Title/Abstract]
Putting it all together

In my experience, the most comprehensive searches are:

- First idea - Search for one concept (not necessarily one word) at a time, then combine all the searches on that idea into a “super search” on that idea

- Use a combination of controlled vocabulary searches and keyword searches for multiple synonyms, limited to title and abstract in most cases. Add them together with OR

- Do the same for the next idea

- Keep going...

- Then add the “super searches” together with AND

- Export results into reference manager software
Say it only once – deduplication of results using EndNote

- Deduplicate results *before* you decide on relevance, so you only need to decide on relevance once for each article
- Create a new Library for every database and have only it open; send the results into it
- In that EndNote Library, select all the records and make sure they all have the database name under Name of Database – if not, select them all, go to Tools > Change/Move/Copy Fields, and under the Name of Database field, choose Replace whole field with: and add the name of the database there
- Close the Library, move on to the next database
- Once you have separate Libraries created for each database, create a new blank “master Library”
- You can create Smart Groups to automatically display how many results you have from each database
Deduplication of results using EndNote II

• Decide which order you are going to import the databases’ Libraries. This is important as it will decide which of the duplicate results you will keep

• *File > Import > File.* Choose the Library (a .enl file), under *Import Options* select *EndNote Library.* Tell it to *Discard Duplicates*

• What counts as a duplicate is decided under *Edit > Preferences > Duplicates.* By default matches must have the same authors, year and title, but variants in spacing and punctuation are ignored. You can make changes here to widen or narrow the definition

• You can find duplicates later by going to *References > Find Duplicates*

• Trust me, there will still be duplicates in there. Order the whole list by author, or by title, to help see them. All things being equal, keep the one with the lower record number – this is the one you imported first, decided by which database you imported before the other
Separate the wheat from the chaff

• *Groups > Create Group Set.* Call it *Relevant?*

• Add groups to it, for example, *Irrelevant* and *Relevant*

• Click in to *Unfiled.* This is important!

• Set the citation style to *Annotated,* and the Reference Panel to *Preview.* This shows you any abstracts that came in with the record

• Work your way through the *Unfiled* records, moving them to *Irrelevant* and *Relevant,* until there are no records left without a group. That way you’ve made a decision about each record
Sanity check

• Do you already know of a really good article?
• Does the search you’ve constructed pick it up?
If no...
• Is the journal in the database? Are others from that issue in it? If yes:
  • What term(s) are missing from your search that would have triggered it to appear? If looking at it as a PDF or webpage, use CRTL + F (Command + F on a Mac) to search for your terms
Finally

• Good searches are done when you are methodical – so you should do systematic searches even if you aren’t doing a systematic review - but with a dash of art as well as science

• You start to know how a particular database works - experience imparts intuition as to when a search is working or not

• Or maybe I’ve just been doing this for too long 😊
For more help...
Jessica Eustace-Cook

- Nursing & Midwifery Subject Librarian
- E-mail: eustacj@tcd.ie
- Tel: 01-8964916
- Office Hours Mon, Tues, Thurs 09:00-16:00
  - Meetings by appointment only